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CES319875-L  

Custom Bridge Parts from Inventor to InfraWorks to 
Revit  
 
 

Description 

Learn hands-on the creation of basic bridge components in Inventor software. InfraWorks 
software can accept custom piers, girders, abutments, decks, and foundations created as IPT 
files in Inventor. In this class, you will model a parametric pier in Inventor and use Shape 
Modeler to prepare it for use in InfraWorks. Once we look at the options in Infraworks, we will 
export the project to Revit.  
 
Speaker 

 
Louisa Holland, Premium Services Specialist, Autodesk 
 
Lab Assistants 

My sincere thanks to the following people:  
 
Sean Hulbert, Designated Support Specialist, Autodesk 
Michael Hurtado, Enterprise Priority Support Specialist, Autodesk 
Creg Dieziger, SR. Civil Engineer Designer, Morrison-Maierle 
 
 

Learning Objectives 

 Understand the basics of parametric modeling in Inventor  
 Understand the parameters required by InfraWorks for parts to be dynamic  
 Learn how to export bridges from InfraWorks to Revit 
 Understand the workflow for creating custom bridge parts 
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Introduction 
 

Goal: 

 

To give designers basic Inventor skills to create a simple bridge 
pier for use in Infraworks. 

  

Notes: 

This is SUPER basic stuff. On purpose. Baby steps.  

 
 

  

Software used in this presentation: 

 Inventor Professional 2020.1 
 Infraworks 2020.1 
 Infrastructure Part Shape Utility (ShapeModeler.msi) 
 Revit Infraworks Updater (IWExportToRevit.msi) 

The installation order will make a difference here. 

1. Inventor  
2. Infraworks  
3. ShapeModeler.msi 
4. IWExportToRevit.msi 

 

 Verify that the Infrastructure Part Shape Utilities appears in the Environments tab of 
Inventor. 

 ShapeModeler.msi is no longer a part of the default Infraworks installer and must be 
downloaded from manage.autodesk.com. 
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Assumptions 
 You are already CAD user and familiar with 3D drafting concepts.  
 You are familiar with Autodesk interface terminology, such as ‘view cube’, ‘template’, 

‘parametric’ etc. 

The Inventor Environment for Civil People 
 

Inventor is initially set up as if you were going to design a mechanical widget, so the default 
coordinate system and units are not ideal for a large-scale object like a bridge pier. In this 
section, we will set up inventor to be more civil-friendly. 

 

Exercise 1:  Make Inventor Feel More Like Home 
 

First, change some settings to make working in Inventor feel more familiar. 

When you first launch inventor, you are presented with a start screen. Like most Autodesk 
products, you can jump right in with a default template or pick an existing one.  

1.1. Launch Inventor Professional 2020 if it is not already open. Click New Part. 

 

 

 
 

Initially, your drawing screen will show the view 
cube and the UCS icon. Notice that the XY plane 
is currently set to Front.  
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1.2. Click the down arrow near the view cube 
and select Set Current View to Top. 

 

Setting the XY plane to Top will make the drawing 
environment feel more familiar.  

 

Z is now “up.” 

 
  

 

Next, we can change the default zoom behavior of Inventor to make it more like AutoCAD. This 
is optional, but if you are used to AutoCAD, the zoom behavior may drive you crazy. 

 

1.3. Go to the File tab and click 
Options.  

1.4. Switch to the Display tab. 
 

1.5. Scroll down until you see Zoom 
Behavior.  

1.6. Place a checkmark next to 
Reverse direction.  

1.7. Click Close.  
 

This changed setting will persist 
between Inventor sessions. 

 

1.8. Save the file to your hard drive 
as Basic Pier.ipt.  
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Exercise 2:  Units in Inventor 
 

In this example, I started with the default US template which is in inches. Because we will be 
working with a large-scale bridge pier, let’s change the units of the drawing to feet or meters.  

2.1. Continue working in Basic Pier.ipt (created in the previous exercise). 

2.2. Go to the Tools tab > Options Panel and click Document Settings. 

 

2.3. Switch to the Units tab. 

2.4. From the Length dropdown, 
select foot.  

2.5. Click Close, then Save the file. 
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Getting to Know Inventor 
 

In the previous section, Make Inventor Feel More Like Home, you switched your mouse wheel 
zoom behavior to act more like AutoCAD.  

Like AutoCAD, holding shift and the middle mouse wheel will put you into 3D orbit mode.  

 

Inventor Basics 
 

Sketch First; then Extrude  
 

 

Inventor works by creating a 2D Sketch and 
then operating on the Sketch to become a 3D 
solid.  

 

 

For example, to make a prism, one would first create a 
Sketch of a rectangle, then extrude the rectangle to the 
desired height. 

 

Sketches can be created directly on a planar surface or on 
a work Plane.  

 

Overview of Sketched features in Inventor  
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Sketches on a Plane 
 

 

Sketches always need to start on a Work 
Plane. When you first open an IPT file, 
you will have XY, XZ and ZY planes already 
to sketch upon.  

 

Once you have geometry in your file, you 
can create planes that relate to your part 
in any way.  

 

 

 

Learn more about work planes and other work features in Inventor Help. 

 

Snapping & Constraints In Inventor 
 

 
Object snaps are always running in Inventor. Keep an eye out for the green dot while 
sketching that indicates you are about to click on significant geometry such as the endpoint or 
midpoint of geometry.  

 

 

 

As you use snaps, Inventor will automatically constrain 
the part.  This behavior is on by default and can be 
controlled in Constraint settings.  

 

 

 

Geometric constraints allow geometry to be dynamic while abiding 
to design rules. Inventor adds constraints as we draw, but you can 
add more as needed.  

 

 

More on geometric constraints in Inventor 
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Parameters! Parameters! Parameters! 
 

Each bit of geometric data entered into Inventor is tracked as a Parameter. Model Parameters 
are created as you sketch and control the measurements of geometry. Unlike AutoCAD, where 
adding parametric behavior is an additional step, Inventor is always keeping track of how our 
geometry relates to itself.   

 

You can name the parameters as you Sketch, or you can open the Parameters manager to add 
names later.  

 

Understanding parameters is critical when exporting to Infraworks. It is parameters that drive 
how (and if) Infraworks understands the design intent.  

 

Infraworks uses the parameter name to “hook in” to the part. Any parameter that you would like 
to view in Infraworks will get a check placed in the Key column of the parameters manager.  

Some significant changes in how Infraworks interprets equations and parameters have been 
recently incorporated into Infraworks 2020.1. Read more about those additions here. 
 
Learn more about parameters in Inventor 2020 here.   
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Exercise 3:  Your First Sketch  
 

A sketch is a 2D drawing which can be used to create 3D geometry. We can turn 2D sketches 
into 3D objects in multiple ways such as using extrude, loft, revolve and sweep, just to name a 
few.  

You can sketch directly on the face of an object or use a workplane.  

Now that you have some basic facts about Inventor under your belt, you can now start 
sketching.  

 

3.1. Continue working in the previous file. If you did not complete 
exercises 1 and 2, you can jump in by opening the file Basic Pier 
(Blank file w units set to feet).ipt. 

3.2. Switch to the 3D Model tab. In your Basic Pier.ipt file, click 
Start 2D Sketch  

3.3. Select the XY plane by clicking it. 

  

 

Even if you have the workplane visibility off, 
you will temporarily see them when 
beginning a sketch.  

 

Notice that the tool tip is helping you figure 
out what input Inventor is looking for.  

 

The Inventor interface will change to sketch mode and display tools that are related to creating 
2D geometry.  

 

 

3.3. Click the top portion of the circle tool.  
 

There are several options for creating a circle, this will 
choose a simple center-radius type circle. 

 

 

 

 

Object snaps are always on in Inventor. The green 
dot indicates that you will be snapping to the origin. 

 

3.4. Move your cursor towards the origin point of 
the sketch.  
Click when you see the green dot. 
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3.5. Type PierDia = 8  and press enter on your 
keyboard. This creates an 8’ diameter circle.  

 

3.6. Next, click Finish Sketch.  
 

 
 

You may need to click Top on the view cube to see the entire circle from the top down.  

Hint: Double-click the middle mouse wheel to zoom extents exactly like you would in AutoCAD.  

Exercise 4:  Extrude the Column 
 

4.1. Continue working in the previous drawing. 

4.2. If you were unable to complete the previous 
exercise but would like to continue, open the file 
Basic Pier (Exercise 4).ipt. 

4.3. From the 3d Model tab > Create Panel, click Extrude. 
  

 

4.4. Set the extrusion height to 
PierHeight=20   

4.5. Verify that your extrusion settings match 
what is shown here.  
 

Click OK.  
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In the next several steps we will manipulate the view to make 
working with our geometry easier. 

 

4.6. Using the view cube, manipulate your view so you are 
looking at the column from a SW isometric view.  

 
Be sure the column is positioned upright on your screen.   

 

 

4.7. Right click the viewcube and select Set Current View 
as Home > Fit to View.  
 

Now, any time you hit the home icon near the view cube 
you will be taken back to the SW Isometric view.  
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Exercise 5:  Sketch the Top of Pier 
 

Continue working in the previous drawing. 

If you were unable to complete the previous exercise but would like to continue, open the file 
Basic Pier (Exercise 5).ipt.  

 

 

5.1. Select the top face of the cylinder.  

5.2. Click Create Sketch from the onscreen tools (or from 
the ribbon) 
 

 
Sketch mode will take your dreawing into a 2D drawing 
environment.  

 

Here is an overview of what we will be drawing in the Inventor sketch. 

 

First we will draw the left and right sides of the pier cap as rectangles. We keep each side 
separate so they can be controlled by the PiercapLeftWidth and PiercapRightWidth 
parameters that are needed by Infraworks. We will then convert the vertical lines of the 
rectangles to construction lines, then finish off the pier with rounded ends. 

Inventor behaves much like AutoCAD with polar tracking enabled.  

As you draw, notice that Inventor is automatically adding contraints to your geometry.  
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5.3. Click the Rectangle command 

5.4. When drawing the rectangle start by snapping to the ”12 o’clock” tangent position on the circle. Drag 
down and to the right until you see the width of the column is 8 feet wide.  

 
5.5. If your cursor is not active in the correct tooltip, press Tab.  

5.6. Type in PiercapRightWidth=15 and press enter.  

  
5.7. If you did the previous step correctly, Inventor will constrain the geometry as shown above.  
 

5.8. Press escape to exit the rectangle command.  

5.9. Delete the vertical line that crosses the diameter of the column.  

 This step is important, as Inventor is sensitive about overlapping sketch lines!  
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5.10. Similarly to the right side, draw a rectangle snapping from the top of the circle. Drag until you reach 8’, 
the type PiercapLeftWidth=13. (4.5m). Use the tab key to verify you are typing in the correct text box. 

5.11. Press ecape to finish the rectangle command.  
 

5.12. Select the remaining vertical lines and the circle geometry by creating a right-
to-left selection box. Just like AutoCAD, this will select objects that touch the 
selection.  

 
 

 

5.13. Now, click the construction line icon from the Format Panel. This hides this geometry when we are 
extruding the top of the pier in the next section.   

 
 
The construction lines will appear as dashed. 

 
 

5.14. Go to the Sketch tab > Create panel. Select the Tangent 
type arc. 

5.15. Sweep your cursor over one of the horizontal lines until 
you see the green dot at the end. This will indicate that 
the arc will be drawn tangent to the line highlighted in 
white.  
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5.16. Click to create the arc along the right side of the pier. 

5.17. Repeat to form the arc on the left side.  

5.18. Press Esc on your keyboard to complete the arc 
command.  

5.19. Click to select one of the horizontal lines.  
 

 

 

5.20. Right-click and select Close Loop. 

 

 

5.21. You may receive an instructional message, reminding you to select lines in order, until 
they form a closed shape. Click OK. 

 
5.22.  Click on each line of our bridge pier cap until the loop is closed.  

5.22a   As you click, you should receive a message that there are multiple sketch points where 
the highlighted curves connect. Would you like to combine the points into a single point?  

5.22b    Click Yes.  
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5.23. When you click the last line, you will receive a message indicating that the loop has been 
successfully closed. Click OK. 

 

5.24. Click Finish Sketch. 

5.25. Save the drawing.  

 

Verifying your Sketch 
 

Let’s spend a few minutes checking out our new sketch.  

 Having a well-drawn and properly constrained sketch is critical for our bridge pier.  

 The top will fail to extrude if there are any open ends or the loop is not closed.  

 You may get unexpected geometry if the sketch is not constrained.  

 

If you closed out of your sketch and need 
to return to edit it, there are several ways 
to get back in. the quickest way is to select 
the geometry and click Edit Sketch.  

 
 

 

To explore your constraints, click the Show Constraints icon in the 
Constrain panel. Select various geometry until you see all the constraints.  
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Right now, your lines are probably partially constrained. The geometry is green, meaning it 
could be constrained further.  

When a line is fully constrained, it will turn blue.  

 

Adding constraints in Inventor is like adding constraints in AutoCAD.  

a. Click the icon for the constraint type you’d like to add. 
b. Click the geometry to link parametrically.  

 

Problem Fix 

Oops, I didn’t snap to my 
column edge. 

No sweat! Click the tangent constraint. Click the line, then the 
column edge. 

 
  

Repeat on the other edge of the column if needed.  

I created my rectangle but 
didn’t do the PiercapLeftWidth 
or PiercapRightWidth correctly.  

Find the Parameters icon at the top of the Inventor Window. 

 You can edit or add parameters in the resulting dialog 
box. We will get more into detail on the parameters dialog box later 
on in this lab.  

My loop didn’t close. ☹ You can force geometry to touch by using the coincident constraint, 
if there are gaps. Another common cause of loops not closing is 
overlapping geometry. If you forgot to delete the vertical line in 
step 5.9, the close loop command may pick the wrong path. 
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Exercise 6:  Extruding the Top & Setting Up Parameters 
 

If you are confident that you drew the piercap correctly, continue working in the previous 
drawing. If you are not so sure, open Basic Pier (Exercise 6).ipt.  

6.1. Click extrude from the create panel.  

6.2. Type in PierDepth=4 .  

6.3. Set the direction to 2 (as shown).  
 

 That means we want the thickness of 
the pier to go down in relation to the 
PierHeight.  

 

6.4. Click OK.  
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Are you ready to set up your parameters? Here we go!  

6.5. Click the parameters button.  

6.6. Check your other model parameters.  

   Verify that you have spelled PierHeight, PiercapRightWidth and 
PiercapLeftWidth correctly and that the case matches what is shown above.  

   Place checkmarks in the Key column for:  

 PierDia  

 PiercapRightWidth 

 PiercapLeftWidth 

 PierDepth 

 PierHeight 
 

 
6.7. At this point, your Parameter listing should match what is shown in the image above.  

6.8. Test your parameters by changing the values in the Equation column.  

 This will ensure that your geometric constraints are set correctly.  
 
For example, if you change the PierDia but the pier cap does not widen accordingly, your sketch 
may need the tangent constraint set.  
 

6.9. Save the file.  
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Exercise 7:  Exporting the IPT to Infraworks 
 

Continue working in the previous drawing. 

If you were unable to complete the previous exercise but would like to continue, open the file 
Basic Pier (Complete).ipt. 

7.1. Switch to the environments tab and click Infrastructure part 
shape utilities. 
 
(If you do not see this button, it is because ShapeModeler.msi needs 
to be installed on your PC.) 

 

 

 

7.2. Click Export Template 
 

 
 

7.3. In the Export Model Template dialog, 
click Browse.  

7.4. Select the desktop of your PC and click 
OK. 

7.5. In the Name Field, type CustomPier01.  

7.6. Click Export. 
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7.7. Click Close.  

7.8. Click Finish Infrastructure.  
 

 
 

Notice the tabs at the bottom left in the screen. 
The Infrastructure part shape utility has created a 
copy of your original Inventor file and saved a copy 
on the desktop. 

 

 

 
 

7.9.  Keep Inventor open, but close the CustomPier01.ipt file by clicking the X.  

7.10. Click Yes to save changes. 

7.11. Minimize Inventor  
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Import Into InfraWorks 
 

Exercise 8:  At last, InfraWorks! 
 

8.12. Launch Infraworks if it is not already started. 

8.13. Click Open. 

 
8.14. Browse to the folder for this class and open Test Bridge.sqlite 

 

8.15. On the Manage tab > Content panel, click Style Palettes 

 
 
  

 
 

8.16. In the Style Palette, switch to the 
Parametric Models tab. 
 

8.17. Double-click to browse to the folder 
Bridge > Piers. 

 

 
 

 
We will create a new folder to keep our custom 
pier separate from the out of the box ones. 

 

8.18. Click the Green plus sign near the top of the 
Style Palette.  
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8.19. Click the Rename button and rename the folder to Custom Piers.  

8.20. Double-click the folder to browse to it.  

8.21. Click the plus icon at the bottom of the Style palette.  
 
You should now see the Define New Parametric Models 
dialog box.  

 

 

8.22. For the Model URI, click the ellipsis to browse to the Inventor file CustomPier01.ipt 
that you previously saved to the desktop. 
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8.23. If everything was defined properly in Inventor, your dialog box should look like the one 
below.  

 

 If you did not get this with the pier you created, browse back out and select the 
CustomPier01 (Complete).ipt file from your class files folder. 
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8.24. Switch to the Part Sizes Tab. 

8.25. Rename the Part Size Name by double-clicking in the 
name field.  

8.26. Set the name to AU2019. 
 

At this point we could continue adding pre-configured part sizes by 
adding columns and changing the parameters as required.  In the 
interest of time, we will not be adding more sizes. 

 

 

 

8.27. Click OK. 

 

  

8.28. Click anywhere in the style palette to complete the 
style creation. 

8.29. Go to the Bookmarks, Select Pier – 1a. 
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8.30. Select the bridge pier assembly.  
 

8.31. Your first click will click the overall assembly, 
which includes the foundation, piers, girders and 
decks. 

 
 

8.32. Click again to select the Pier. 
 

8.33. The properties dialog box should reveal that it is 
an Enhanced Standard Pier. Click the hyperlink 
Enhanced Standard Pier. 
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8.34. In the Select Component asset card, double-
click the AU2019 pier from the top of the list.  

 

 
 
 

 Notice anything wrong with the pier? It is rotated incorrectly by 90°. This is easy to 
resolve, however.  
 

8.35. Back in the style palette, double click to edit the CustomPier01.  

 
8.36. Change the rotation in the Z axis to 90° as shown above. 

8.37. Click OK. 

8.38. Press F5 on your keyboard to regenerate the model.  
 
You should now see that the pier is placed correctly.  
 

8.39. Go to the Bookmarks Select Pier – 1a. 

8.40. Right-click the pier and select Apply To… > Next Selection.

 
8.41. Click any pier (or piers) and press enter.  

8.42. Press escape to clear any selections. 
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Exercise 9:  A Bridge to Revit 
 

9.1. Select the pier assembly. Right-click and 
select Send to Revit > Create New 

9.2. Select the bridge. (to verify you have the 
bridge selected )  
 

 

9.3. Leave the Location and proposal name as default. Click Create.  
 

 

It will take several minutes as Infraworks packages up the bridge and creates an IMX file.  

 

 

 

While this is exporting, see if any of your lab neighbors could use your help.  

 

9.4. Launch Revit 2020 if it is not already open. 

9.5. Click New… 

9.6. Choose the Structural Template and click OK.   
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9.7. Go to the Add-ins tab > Infraworks Structures panel and click Import Civil Structures 

 

 

It will take several minutes for all the data to import to Revit.  

9.8. When the structures have finished importing, click the 3D view icon from the quick access 

toolbar.    

 

 

 

This is the end of the exercises.  
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Revit and Beyond 
 

Revit for Rebar 
Once your project is in Revit, you can start working on structural details such as placing rebar.  

Check out this video on placing rebar in imported features. 

What Happens If a Design Change Occurs in Infraworks? 
 

 

Design changes on your bridge can be updated by re-exporting from Infraworks. When working 
with design changes, be sure to use Update Existing as the option.   

 

Update simply prompts you to overwrite the IMX created on the initial export.  

 

On the Revit side, you will be prompted to accept the changes.  
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To accept the changes in Revit, click Apply.  

Any rebar you placed will update as well. 

Further Study and Other Helpful Links 
 

All three parameters for the bridge pier must be present. PierHeight is the main driver of the 
geometry and is set by Infraworks. Therefore, required parameters (such as PierHeight) 
cannot be a calculation in Inventor.  

 If there are required parameters missing, Infraworks will not recognize the part.  

Parameter Name Required in: 

PierHeight Pier 

PiercapLeftWidth Pier 

PiercapRightWidth pier 

CLBearingToBBW abutment 

LeftWidth abutment 

SeatDepth abutment 

SeatOffset abutment 

SeatWidth abutment 

LeftWidth deck 

RightWidth deck 

 

There are no required parameters for: 

 Foundation 
 Girders 
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Helpful Links 
About Parametric Models in Bridge Workflows 

Sharing Parametric components 

The official workflow from Inventor to Infraworks 

An entertaining introduction to workplanes: https://www.youtube.com/watch?v=KdJAYagKNVY 

To learn more about using parametric constraints in Inventor, check out this video by Faith 
Caplan. 

 

 


